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EpiGraph: an open-source platform to quantify 1 

epithelial organization. 2 

 3 

Supplementary Information. 4 

 5 

SUPPLEMENTARY MATERIAL AND METHODS 6 

EpiGraph Source code. 7 

The project’s code is accessible through Github 8 

https://github.com/ComplexOrganizationOfLivingMatter/Epigraph. It is open 9 

source and available under GPLv3 license. 10 

Pipeline. 11 

The image processing pipeline entails cell recognition, valid cell identification, 12 

graph of cell-cell contact creation, polygon distribution analysis and, finally, Epi-13 

Hexagons, Epi-Random and Epi-Voronoi5 calculation. These stages are properly 14 

described in the subsequent paragraphs. Moreover, a full set of tutorials 15 

explaining how to install and use EpiGraph are available at EpiGraph’s wiki 16 

(https://imagej.net/EpiGraph). In addition, Movie S1 summarizes a general 17 

example with default options. 18 

 19 

- Recognition of existing cells 20 

EpiGraph uses segmented images from natural tissues or simulations as an 21 

input. These images must be built in binary format, where one colour should be 22 

presented as the background, forming the body of cells, and the other one the 23 

cells outline. Each cell is assigned a label using MorphoLibJ (Legland et al., 24 

2016). This identifier allows us to have a record of every cell and its location on 25 

the image, which is necessary for the following steps. 26 

- Identification of valid cells 27 

Once we have properly labelled the image, we proceeded to fully analyse it. By 28 

default, an invalid region is created, which is initially defined by the boundaries of 29 

the image itself. We select all the cells that fall outside of this border and set them 30 

https://github.com/ComplexOrganizationOfLivingMatter/Epigraph
https://imagej.net/EpiGraph
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as non-valid cells (note that non-valid cells are different from invalid regions, i.e. 1 

the latter are not cells). In this way, we avoid incorrect characterization of polygon 2 

distribution due to the lack of real neighbours in the margins of the image. 3 

However, it is also possible to create a personalized invalid region, by selecting 4 

as many cells as you want. 5 

In addition, we define another two kinds of valid cells: the 3-distance valid cells 6 

and the 4-distance valid cells. The former represents the cells that do not have a 7 

non-valid cell within a distance of three cells connexions. The later kind is formed 8 

by the cells having all valid cells in a maximum length of four cells connexions. 7-9 

motifs and 10-motifs require 3-distance valid cells and 17-motifs and 29-motifs 4-10 

distance valid cells. 11 

- Neighbourhood creation  12 

An epithelium can also be considered as a tessellation because there is no 13 

space between each cell.  Thus, inspecting the number of sides of the cells, we 14 

can measure the number of neighbours that will surround it. We, therefore, extend 15 

a mask from each pixel of the cell with a given shape and size, both selected by 16 

the user. Then, we capture all the cells distinct from the actual cell that fall into 17 

this mask and add them as neighbours of the concrete cell. Afterwards, we create 18 

a neighbourhood network, modelling each cell as a node and connecting two cells 19 

with an edge if they are neighbours. 20 

- Polygon distribution analysis 21 

The polygon distribution is defined by the number of sides of every valid cell. 22 

We specify three different areas: the global zone formed by all valid cells, the 23 

region in which 3-distance valid cells are contained and the territory in which 4-24 

distance valid cells are placed. For 7-motifs and 10-motifs, we use a path of 4-25 

nodes length (3-distance valid cells as orbits nodes, and any type of valid cell as 26 

its branching nodes), and for 17-motifs and 29-motifs the area is defined by the 27 

cells contained within the path of 5-nodes length (4-distance valid cells as orbits 28 

nodes, and valid cells as its branching nodes). Finally, we calculate the polygon 29 

distribution regarding the cells involved in the graphlet calculation. 30 
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- Epi-Hexagons, Epi-Random and Epi-Voronoi5 calculation 1 

We have adapted Graphlet degree Distribution agreement Distance (GDD) from 2 

Yaveroğlu et al. (Yaveroğlu et al., 2014) to fully integrate it with FIJI java 3 

environment. We use GDD to compare two images and describe how similar they 4 

are. In particular, minimum distance value (0) means two images are equal, and 5 

maximum distance value (1) specifies that they are very different in terms of 6 

graphlets. We compute all the graphlets in which the valid cells participate. Then, 7 

we use only the graphlets in which 3-distance or 4-distance valid cells are 8 

included (depending on the set used). We defined three references to compare 9 

with the real images. The first one is the Graphlet degree Distribution agreement 10 

Distance Random Voronoi (Epi-Random). A random Voronoi (RV) emerges from 11 

500 seeds randomly placed. Then, we computed the GDD between each one of 12 

the 20 RV images and the input image and used the mean of these 20 GDDs as 13 

final distance. We also calculated the Graphlet degree Distribution agreement 14 

Distance Hexagons (Epi-Hexagons), which measures the difference between a 15 

given image and a regular tessellation of hexagons, in a similar way to the Epi-16 

Random. Finally, we computed the Graphlet degree Distribution agreement 17 

Distance Voronoi 5 (Epi-Voronoi5) by comparing a given image with 20 diagram 18 

5s from the CVT path and calculating its mean. 19 

- Statistical analysis 20 

Right before adding all the GDD values to the table, we performed a statistical 21 

analysis (see Material and methods, statistical analysis) to calculate the 22 

closest diagram on the CVTn. This test provides a confidence score determining 23 

if the source image is part of the CVTn path of reference or, on the contrary, is 24 

an outlier. 25 

Graphical user interface. 26 

ImageJ’s FIJI distribution (Schindelin et al., 2015, 2012) provides a framework, 27 

which offers a range of functions and a suitable predefined application 28 

programming interface (API). Furthermore, it allows users with no programming 29 

expertise to execute and exploit all their functionalities. EpiGraph is prepared for 30 

heavy processes. In these cases, some operations such as “calculate graphlets”, 31 

run in the background, giving the user the possibility to move around the 32 
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application smoothly. In addition, a progress bar displays the evolution of the task 1 

in case it may take longer than expected. FIJI works on the three main Operative 2 

Systems (Linux, Mac and Windows) without requiring Java installation since it is 3 

usually embedded in the program. FIJI describes different ways it can be 4 

operated by external software. One of them is constructing a plugin, which is used 5 

by EpiGraph as basic structure to start building. Using Java Swing GUI libraries, 6 

we have designed the three windows of the EpiGraph plugin.  7 

- Main Window 8 

The program starts after clicking on Plugins>EpiGraph. The first window that 9 

appears is the Main Window. It contains a table of processed images (therefore, 10 

initially it is empty). Each table row corresponds to a single processing of image 11 

and comprises the following columns: Colour, label, Epi-Hexagons, Epi-Random, 12 

Epi-Voronoi5, percentage of hexagons, radius of shape, type of shape, kind of 13 

graphlet calculation, closest diagram, confidence score and a checkbox. Colour 14 

column lets you pick the colour of the point from the palette to be visualized later; 15 

Label shows the name of each image; Epi-Hexagons, Epi-Random and Epi-16 

Voronoi5 represent the GDD of the image against hexagons, random Voronoi 17 

diagrams and Voronoi 5 diagrams from CVTn, respectively; Percentage of 18 

hexagons contains the proportion of hexagons for all valid cells involved in 19 

graphlet calculation; Radius specifies the shape size used to calculate 20 

neighbours; Shape characterizes the type of form used to calculate 21 

neighbourhood; Kind of calculation displays which set of graphlets was used; 22 

Closest diagram represents which number Voronoi diagram from the CVTn is 23 

closest to the image; Confidence score is the certainty of the image being an inlier 24 

of the point cloud of that diagram. Finally, Select column lets you choose, by 25 

means of a check box, whether you visualise the calculated data in a 3D viewer 26 

or not, and in the same way, removes the selected rows if you click on the button 27 

remove rows. Additionally, you do not need to calculate the graphlet properties 28 

every single time. Instead, it is possible to import your own dataset from a 29 

properly formatted Excel file, using the import table button. Likewise, once you 30 

have already analysed several images, you can export your information into an 31 

Excel file, using the export table button. The exported table includes the polygon 32 

distribution of the cells involved in the graphlets calculation. Lastly, you have the 33 
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option of representing all table rows, by ticking the “true” check box. For that, you 1 

should click on the visualize button to launch the mentioned 3D viewer. 2 

- Image processing Window 3 

This window will be automatically triggered when a supported file format is 4 

correctly selected, after clicking the open main window button. This window is 5 

composed of a button panel with different processing options, a canvas with the 6 

loaded image embedded in it and a polygon distribution legend. The only enabled 7 

button when the window is first opened, will be the mode in which you label the 8 

image. You can choose to label this image using either 8-connectivity or 4-9 

connectivity and then click on the label image button to execute it. After these 10 

other buttons become enabled. These buttons are classified in 3 panels:  11 

• Region of interest. The main objective of this panel is selecting regions of 12 

interest so that only valid regions are processed and invalid ones are 13 

discarded. The create ROI and select cells buttons let you select various 14 

rectangular (default) regions and pick individual cells using the FIJI’s ROI 15 

manager tool. You can repeatedly combine both options to establish a 16 

valid region in which to operate. Furthermore, you can change the ROI 17 

selection shape, from rectangular to another shape, using FIJI’s control 18 

panel. On the other hand, there is the option to choose an invalid region 19 

by clicking over it, after clicking the add invalid regions button. This action 20 

only lets you store a single set of invalid ROIs at a time, so if you wanted 21 

to add an invalid region after saving previous invalid regions, you must 22 

delete the former to include a new one. 23 

• Neighbourhood. This panel allows you to visualize valid and non-valid 24 

cells, invalid regions and polygon distribution values from the current 25 

image. To calculate the neighbourhood you should select, using the 26 

number selector (located close to radius), a size of shape in pixels and a 27 

specific geometrical shape using the tool described above (located next to 28 

shape). This selection depends on the width of the cell outline. If the border 29 

cells have a width of 1 pixel, it is enough using a size of 3 pixels to explore 30 

the cells vicinity. By default, we expand 3 pixels each cell, using the 31 

circular shape, to look for their neighbours. For wider border cells, you can 32 

choose higher size of mask with either circular or squared shape. Once 33 
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the parameters have been selected, the test neighbours button can be 1 

pressed to calculate the neighbourhood for the valid cells belonging to the 2 

ROI. If the ROI is the whole image, a column next to the legend of polygons 3 

shapes, headed by “Graphlets”, would be filled with the polygon 4 

distributions of the valid cells. Otherwise, if the ROI is a subsection of the 5 

image, a new column appears next to “Graphlets” headed by “ROIs” that 6 

will be filled by the polygon distribution of the valid cells belonging to this 7 

ROI. Note that in this case, the “Graphlets” column would be filled with the 8 

polygon distribution of the all valid cells participating in the ROI graphlets 9 

calculation.  10 

Finally, when the columns are filled, an overlay is displayed on the canvas, 11 

representing each cell colour coded by polygon number. These colours 12 

are the same that the ones at the legend located at the left of the window. 13 

In addition, the toggle overlay button lets you choose whether to visualize 14 

the overlay created by test neighbours. The invalid regions and the cells 15 

outlines are labelled in black in the overlay, dark grey marks non-valid 16 

cells, and the rest of colours (represented in the polygon distribution 17 

legend) are reserved for valid cells. It is important to highlight that the 18 

bright colours of the legend displayed over the canvas represent the 19 

number of sides of the valid cells into the ROI. The same pale colours 20 

represent the polygon distribution of valid cells located out of the ROI, yet 21 

which still contribute to the graphlet calculation of cells within the ROI. A 22 

4-distance valid cell is a cell that do not have a no valid cell within a 23 

distance of four cells connexions. Moreover, a 3-distance valid cells have 24 

no valid cells in at least three branched cells.  25 

• Graphlets. This panel is designed with the aim of saving graphlet data 26 

internally and externally. There is a text box where you can add the data 27 

label (image name by default), located after image label text. You can also 28 

select a colour label for your data, using pick a colour button. Finally, you 29 

can choose the appropriate method to calculate graphlets data. The 30 

options are: 26 graphlets representing 29 cellular motifs (29-motifs), 17 31 

graphlets that are contained in 17 cellular motifs (17-motifs), 9 graphlets 32 

on behalf of 10 cellular motifs (10-motifs) and 7 graphlets typifying 7 33 

cellular motifs (7-motifs). 7-motifs and 10-motifs are formed by graphlets 34 
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of maximum 4 nodes, while 17-motifs and 29-motifs make use of graphlets 1 

of maximum 5 nodes. 7-motifs and 10-motifs are most useful when images 2 

have a small number of cells, since both require fewer cells than 29-motifs 3 

and 17-motifs. Once the method has been selected, you can then click the 4 

calculate graphlets data button to acquire data for all calculated graphlets. 5 

When this process is complete, data are automatically added to the main 6 

window table. Furthermore, by clicking on Export Graphlet data you can 7 

export a ZIP file containing: a JPG image representing the neighbourhood, 8 

another JPG image capturing the label of the cells, a CSV file storing all 9 

calculated graphlet data and a .sif that represent the neighbourhood 10 

network. 11 

The window has a progress bar that estimates the process state. You can 12 

modify the image zoom by pressing control and rotating the mouse wheel at same 13 

time. 14 

- Visualizing Window 15 

We use a 3d viewer to display our calculated results stored in the main window’s 16 

table. When a row´s checkbox is ticked, it will be plotted. To develop this window, 17 

we have used an open source library named Jzy3D (http://www.jzy3d.org/) that 18 

is able to generate different graphical representations. In particular, we make use 19 

of the 3d scatter plot class. 20 

 This window is displayed after clicking on the visualize button (located in the 21 

main window), even if your table is still empty. This window is composed of the 22 

scatter plot figure located on the left and a set of components to modify the 23 

appearance of this figure on the right. The plotted figure is delimited by a 3D box 24 

with 3 axes: Percentage of hexagons, Epi-Hexagons and Epi-Random by default. 25 

These 3 axes can be replaced by any of the following configurations (𝑋𝑋 − 𝑌𝑌 − 𝑍𝑍 26 

axes) using the drop-down list with the label Axes of figure (upper right corner of 27 

the window): 28 

1- Epi-Hexagons, Epi-Random, Percentage of hexagons (default) 29 

2- Epi-Hexagons, Epi-Random, Epi-Voronoi5 30 

3- Epi-Hexagons, Epi-Voronoi5, Percentage of hexagons 31 

4- Epi-Random, Epi-Voronoi5, Percentage of hexagons 32 

http://www.jzy3d.org/
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The Percentage of hexagons axis encapsulate values between 0 – 100, and the 1 

others between 0 – 1. These limits can be modified for zooming in on the 2 

individual axes. We used three rangeSliders to select the range for each axis to 3 

be represented due to the limitations of the Jzy3D library. This library only 4 

provides you the possibility of zooming the 𝑍𝑍 axis turning the mouse wheel. You 5 

can visualize the three rangeSliders (one per axis) just below the Axes of figure 6 

drop-down list. 7 

By default, the scatter plot displays the CVTn path, shown as individual dots: 8 

The darkest dot represents the average of 20 Voronoi diagrams 1 in CVTn and 9 

the lightest one is the average of 20 Voronoi diagrams 700 in CVTn. You have 10 

the option to disable the visualization of these references clicking on the 11 

checkbox ‘Show reference’ (just below rangeSliders), to only display calculated 12 

data. One can also adjust the size of the dots by modifying the position of the 13 

slider bar, located just below the previously mentioned checkbox. To select the 14 

different modes in which graphlet data of the CVTn reference can be calculated, 15 

a drop-down list can be deployed by clicking on the label Motifs of CVTn 16 

reference. This list allows you to represent the CVTn path depending on the 17 

method with which the graphlets were calculated: 29-motifs, 17-motifs (by 18 

default), 10-motifs and 7-motifs. In this way, you can export the visualized CVTn 19 

path by clicking on the button with label “Export actual CVT reference” as an excel 20 

file with the GDDs to represent yourself your acquired data elsewhere (as in 21 

“Export table” of the Main Window). 22 

The dots shown in the figure in the Main Window can be modified by changing 23 

the colour box in the Main Window’s table. In addition, a .png figure screenshot 24 

can be saved, by pressing the Export view button. For more detail, different 25 

angles and modes of visualization are available. By clicking the figure and moving 26 

the mouse, one can change the viewing angle, while double clicking on the figure 27 

will automatically perform a 360 degrees’ rotation. 28 

Functionalities. 29 

Along the program execution pipeline, there is the opportunity to develop a set 30 

of functionalities: 31 
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- Label image 1 

Once you have selected an image to process, this image is binarized and the 2 

background is analysed to detect the cells and their outlines. If the number of 3 

white pixels is higher than black pixels, white pixels will be considered as cell’s 4 

body, and vice versa. After that, each cell’s body region of the image is assigned 5 

with a unique label. Thanks to the extensible architecture of FIJI, in which you 6 

can install plugins to add additional functionalities, this process of labelling 7 

regions is made using MorphoLibJ functionalities. Specifically, we have used the 8 

connected component labelling, which transforms a binary image into a labelled 9 

one by assigning a specific number to each connected component. 10 

- Create ROI 11 

Though it is possible to analyse the entire image, you can also process a smaller 12 

region of interest (ROI). Through FIJI’s Roi Manager we can manage the ROIs, 13 

saving and performing operations on one at a time. We have selected two default 14 

operations within EpiGraph: rectangle (or any available shape) and multipoint 15 

selection. The former creates a rectangle selection (by default) and defines all 16 

the cells that fall inside it as valid cells. The latter enables the multipoint function 17 

with which it is possible to select individual cells. However, it is also possible to 18 

change these default forms of selection, by going straight to FIJI’s main window 19 

and picking any from the toolbar. 20 

-Select invalid regions 21 

As your image may contain artefacts in the form of false valid cells, we have 22 

made it possible to mark these zones as invalid regions. All valid cells 23 

surrounding the mentioned invalid region will be considered as “non-valid cells”. 24 

It is possible to select several areas of the image using the multipoint tool, to 25 

convert them to invalid sections. To validate this action, the selected invalid 26 

region should have the same colour as the cells’ background. 27 

- Testing neighbours 28 

As mentioned the previous section, EpiGraph is able to calculate the polygon 29 

distribution using 2 essential parameters: a given pixel radius and an element 30 

shape. The element shape expands to a given radius of the cells of interest, 31 

looking for cells neighbouring. To ensure that the neighbourhood is correctly 32 

captured, we allow the users to verify if the image has the right parameters by 33 
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themselves. The polygon distribution of the image will appear with numbers at 1 

the left side of the window and each cell will also be painted with a colour 2 

representing its number of sides. Additionally, non-valid cells are coloured dark 3 

grey (almost black). Depending on the method chose to calculate graphlets (29-4 

motifs or 17-motifs considering 4-distance valid cells; 10-motifs or 7-motifs 5 

considering 3-distance valid cells), the zone coloured with bright colours will be 6 

established only by a group of central cells. In the same way, when we select a 7 

ROI, the cells affecting the cells within the ROI will be represented in pale colours. 8 

Furthermore, due to the variant number of 3-distance and 4-distance valid cells 9 

that are going to be filling the ROI, you may encounter when a series of 10 

particularities: 11 

o Some cells of your defined ROI could not be final valid cells (3-distance 12 

or 4-distance). If the ROI is not surrounded by a minimum of 4 cells in all 13 

directions, the number of 4-distance valid cells is going to be lower than 14 

the number of 3-distance valid cells. Thus, if you select 17-motifs or 29-15 

motifs, some cells will not be 4-distance valid cells and will not be used 16 

in the final graphlet computation as principal nodes. 17 

o An empty ROI. If you select a region with no 3-distance or 4-distance 18 

valid cell, you will obtain an empty neighbourhood. 19 

o The pale coloured cells affecting the 3-distance or 4-distance valid cells 20 

will differ, when switching from 17-motifs to 7-motifs (for example). 21 

Therefore, a different number of cells will be affecting the bright coloured 22 

cells. 23 

Finally, the calculations for neighbourhood will be exploited by calculate 24 

graphlets module, if parameters are not modified since this step. 25 

- Calculate graphlets 26 

The main function of EpiGraph is the graphlet comparison. It begins by checking 27 

if there are any selected cells or ROIs. Then, in case any configuration has 28 

changed, we re-compute the neighbourhood, otherwise we take the information 29 

from a previous computation. From this neighbourhood and valid cells, it 30 

calculates the graphlets for the involved network of neighbours. As mentioned in 31 

previous sections, it would be incoherent not to filter the graphlets, so we refine 32 

it by adding only the nodes at a fixed distance from the border nodes to the final 33 
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graphlets. We first calculate the total set of graphlets for valid cells and then select 1 

a filter that depends on the chosen type of Graphlets to be implicated: 29-motifs, 2 

17-motifs, 10-motifs and 7-motifs.  The involved orbit nodes for graphlet 3 

calculations will be referred as 3-distance and 4-distance valid cells. When we 4 

have the final graphlets, we calculate the three distances (Epi-Hexagons, Epi-5 

Random and Epi-Voronoi5). Depending on the number of graphlets selected, a 6 

variable number of orbits are used in the comparison. Finally, the results will be 7 

added automatically to the table on Main Window.  8 

- Statistical analysis 9 

  Once all GDD data from an input image have been calculated, a statistical 10 

analysis is carried out to check if the GDD values of a certain image matches with 11 

the CVTn scale or if the image is out of the CVTn path in terms of organization. 12 

First, the closest CVTn diagram to the image is computed, estimating the 13 

Euclidean distance by considering 3 dimensions: Epi-Hexagons, Epi-Random 14 

and Epi-Voronoi5. Thereafter, it is checked whether the image could belong to 15 

the closest diagram CVTn point cloud. At this point, the method generates a 16 

confidence score for the comparison to the CVTn (see Material and methods, 17 

statistical analysis). The closest diagram and the confidence score are 18 

computed and added to the main window table immediately upon calculating the 19 

GDD values or importing from an existing excel document. Alongside these two 20 

parameters, when exporting to an excel, the Euclidean distance to the closest 21 

diagram is also presented as a column. 22 

- Visualization 23 

Visualizing results properly is a major feature and an important challenge to 24 

interpret results. Thus, we have embedded Jzy3d chart in a Java JDialog where 25 

you can visualize the calculated results’ three coordinates (any combination of 26 

Epi-Hexagons, Epi-Random, Epi-Voronoi5 and percentage of hexagons) as a 27 

point in a scatter plot. Once the points are represented you can compare them 28 

with our CVTn reference. At this point, you may want to change the illustrated 29 

CVTn selecting the number of graphlets used on the computations, although it is 30 

advisable to compare images with the same configuration (7-motifs, 10-motifs, 31 

17-motifs or 29-motifs). Additionally, it is possible to increase or decrease the size 32 
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of the dots and zoom each axis manually. Finally, you can export the actual view 1 

of the chart to an image file. 2 

Dependencies. 3 

FIJI is designed to add functionalities via several routes, one of which is Plugin. 4 

In order to have simple control of dependencies and project settings, it uses 5 

Maven. Maven is a tool that is broadly used for supervising and building Java-6 

based projects. It integrates several tools, such as Javadoc, to make all the 7 

programming steps easy. Dependencies are downloaded and updated when 8 

available. Furthermore, it helps you create the package with all your code and 9 

zips it in a .jar file that will be the Plugin format of FIJI.  All this is achieved through 10 

its project object model (POM), which you can shape to your project adding 11 

mailing lists, issue tracking and more. 12 

Supported file formats. 13 

EpiGraph’s input is an image. This image should be properly segmented and 14 

grey-scale, however, there are several options within EpiGraph to configure it 15 

depending on the type of the image. We allow images with different sizes of 16 

borders, since it is possible to increase the radius of the mask, changing the way 17 

in which the neighbourhood is built. However, it is mandatory that images are 18 

binary images (8 and 32 bits RGB images can be loaded, but they might not be 19 

correctly computed), where one colour is presented as the background, forming 20 

the body of cells, and the other the cells outline. Regarding the image file 21 

extensions, we entrust FIJI with the image opening and the supported files, so 22 

individual image file extensions allowed by FIJI would be supported in EpiGraph. 23 

We cannot admit any sequence of images and the program is sensitive to single 24 

images with high resolution. Accordingly, we warn the user when the images 25 

overpass the 3000px either along the height or width, to prevent possible 26 

execution problems due to the high computational complexity. 27 

Quick step-by-step EpiGraph’s usage. 28 

- Installation 29 

Through FIJI/ImageJ update site: 30 

The usual way to install a FIJI plugin is through his on-site updater. It’s usually 31 

located on “Help > Update FIJI”. Once it is open, you click on “Manage updates 32 
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sites”, look for EpiGraph and tick the checkbox next to it. Finally, “Apply changes” 1 

and you should have successfully installed this plugin. With this option, you can 2 

automatically get the latest version of EpiGraph. 3 

Manually: 4 

On the other hand, you may just want to download the .jar file from 5 

http://bit.ly/EpiGraph-1-0-2 (or even generate your own .jar from source code) 6 

and install it manually. To do this, you can click either Plugins>Install or 7 

Plugins>Install PlugIn. Then you select the provided .jar and you should be able 8 

to run EpiGraph. 9 

- Simple example of a complete analysis 10 

Calculate Epi-Hexagons, Epi-Random, Epi-Voronoi5 and percentage of 11 

hexagons from a given image and visualize it in the 3D visualizer.  12 

1. Select open. 13 

a. Select a supported image. 14 

b. If the image is supported, a window with the image will open. 15 

2. Pick connectivity: 16 

a. Select the connectivity of your image. Usually 8-connectivity. 17 

b. Press label. 18 

3. Default configuration: 19 

a. Radius of 3 pixels. 20 

b. Circle shape. 21 

4. Calculate graphlets and statistics: 22 

a. Write a name for your image. 23 

b. Pick a colour for your image. 24 

c. Select 29-motifs in the combo box. 25 

d. Press calculate graphlets. This will calculate Epi-Hexagons, Epi-26 

Random and Epi-Voronoi5. 27 

e. When GDDs have been calculated, a statistical analysis is carried 28 

out providing a confidence score and the closest CVTn diagram to 29 

the image. Once it is finished, if the name box is not empty, all data 30 

will be automatically added to the main window table. 31 

 32 

5. Export graphlets data: 33 

http://bit.ly/EpiGraph-1-0-2
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a. Press the Export graphlets data button. 1 

b. EpiGraph create a zip folder containing several files; an image with 2 

all the cells labelled with their corresponding identifier, another 3 

image representing the polygon distribution and, finally, a ‘.csv’ file 4 

with the graphlets for all the valid cells. 5 

6. Visualize your results: 6 

a. Return to the main window. 7 

b. Click on visualize. 8 

7. Export view: 9 

a. Staying in the visualizing window, you have the option of exporting 10 

the actual view into a ‘.png’ file at every stage. 11 

b. Press export view. 12 

Congratulations! You have done the complete pipeline. Now, check where your 13 

image is in regard to the CVTn scale. You should analyse whether or not your 14 

image is near the CVTn (reference), which can be done using its closest diagram 15 

and confidence score from the table. 16 

- Create region of interest 17 

If you wish to test a sub-region of your images, you can create a region of 18 

interest (ROI). We have already opened an image and labelled it within EpiGraph. 19 

1. In the image processing window: 20 

a. Press Create ROI. 21 

b. The default ROI is square shaped; however, you may want to test 22 

another shape. You can now return to the FIJI application and 23 

select any of the existing ones on the toolbar. 24 

c. Click done. Your ROI is managed and stored in FIJI Roi Manager. 25 

You have created your ROI; however, you cannot see how it affects the image 26 

yet.  27 

2. Press Testing neighbours: 28 

a. An image representing each cell by its number of neighbours 29 

will appear as an overlay in your image. Remember that the valid 30 

cells in the ROI, which appear with intense colour, are the 3-31 

distance or 4-distance valid cells (depending on your graphlet 32 

selection), and the pale colours represent the rest of valid cells that 33 
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affect the computation of graphlets. The result will be represented 1 

in the polygon distribution legend. 2 

 3 

Once this procedure has been accomplished, you can continue the execution in 4 

the same way as before: graphlet calculation and statistics, export of results and 5 

visualization. 6 

- Combine ROIs 7 

As regions of interest are managed by the ROI manager you can add several 8 

ROIs to the image. You have already opened the image and properly labelled it. 9 

1. Press Create Roi: 10 

a. Select a left-hand region with the rectangular ROI shape. You 11 

should not select any of the cells on the right-hand side yet. 12 

b. Done. 13 

2. Select individual cells: 14 

a. Click Select cells. 15 

b. Pick only cells on the right-hand side of the image. 16 

3. Test your setup: 17 

a. You should be able to see the cells that fall into both ROIs. 18 

b. Press test neighbours. 19 

4. Oh! You realize you have made a mistake: 20 

a. You do not want the first ROI. 21 

b. Go to the ROI manager. 22 

c. Select the first ROI and click Delete. 23 

5. Test the new selection: 24 

a. You will now represent only the existing ROI on the right. 25 

b. Click test neighbours again. 26 

If you create some ROIs, the selected cells will be all the cells that fall into any 27 

of the ROIs. The logical operation would be an OR, so ROIs could be 28 

disconnected. 29 

- Selection of the number of motifs 30 

There are 4 possible configurations. In this example we will create an analysis 31 

with 29-motifs using 26 graphlets. 32 
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1. Open an image representing cells with 4-connectivity and borders with 1-1 

pixel width. 2 

2. Label it: 3 

a. Click label. A warning notice advises that there are very few cells in 4 

the image. Your full image is tagged with the same label because 5 

all the cells are connected.  6 

b. Select now 4-connectivity. 7 

c. Click label. That works as expected! Each cell has a different tag. 8 

3. Test neighbours by default. 9 

4. 29-motifs: 10 

a. This configuration has the maximum number of graphlets present 11 

in our study. 12 

b. Change the combo box to 29-motifs. 13 

5. Calculate graphlets: 14 

a. Add a proper name to your image. 15 

b. Press calculate graphlets to add the full results to the table. 16 

6. Visualizing: 17 

a. Change the colour of your row to a pink-ish colour. This will let you 18 

differentiate your data from the reference, which is black, grey and 19 

almost white. 20 

b. Click on Visualize. 21 

c. As a default, your reference is 17-motifs. So, change this option in 22 

the combo box to 29-motifs. 23 

d. Modify the axes of figure to ‘Epi-Hexagons, Epi-Random, Epi-24 

Voronoi5’. 25 

e. Change the range sliders at your right side to get an adjusted 26 

visualization per axis. 27 

You will see that the reference has changed regarding the default 17-motifs 28 

reference. Your image is probably aligned to the CVTn reference. This is because 29 

your image is within the CVTn path, otherwise the image organization would be 30 

different to our model of reference. You can verify this with the confidence score, 31 

which also provides the closest diagram to the input image. 32 



 
17 

- Increase the radius of neighbourhood. 1 

You have a segmented image with a border wide of 3 pixels, and you want to 2 

capture the real number of neighbouring of each cell. You have already opened 3 

the image and properly labelled it.  4 

1. Test if neighbours are correct: 5 

a. Since you do not know which pixel radius you should select, test 6 

various shapes and radii in order to see if the cells with 6 7 

neighbours are actual 6-sided cells. 8 

b. Change parameters and click on test neighbours to make sure the 9 

neighbourhood is correct. 10 

Once your polygon distribution is correct enough, you can follow the next step 11 

of the analysis protocol. 12 

 13 
- Import/export table 14 

You may want to save your results and to do this you can export your results to 15 

an excel file, simply by pressing the button export in the main window.  16 

On the other hand, if you would like to continue your session right where you 17 

left off, you could import your exported excel file to the table and carry on with 18 

your analysis. You can add as many .xls files to the table as you want and we 19 

allow duplicates. If you want to remove them, just tick them at the Select all 20 

column and click on Delete rows. 21 

Another option is to calculate the mean values of a particular set of images 22 

outside EpiGraph. To do this, import the excel with the mean values. EpiGraph 23 

will automatically calculate all the values of the closest diagram and its associated 24 

confidence score, enabling you to improve your analysis on that dataset. 25 

 26 

Troubleshooting 27 

If the visualization is not working properly, you may need to update FIJI after 28 

the installation. 29 

If you find something is not working with any functionality of the application, you 30 

can send an e-mail to pvicente1@us.es or pgomez-ibis@us.es. Reporting bugs 31 

can also be done through Github 32 

mailto:pvicente1@us.es
mailto:pgomez-ibis@us.es
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https://github.com/ComplexOrganizationOfLivingMatter/Epigraph/issues. Known 1 

issues are held at the same page. 2 

 3 

License Information. 4 

To encourage the sharing of resources, EpiGraph is published under an 5 

open-source (GPLv3) license, which can be downloaded from 6 

https://github.com/ComplexOrganizationOfLivingMatter/Epigraph/blob/master/LI7 

CENSE. 8 

 9 

  10 

https://github.com/ComplexOrganizationOfLivingMatter/Epigraph/issues
https://github.com/ComplexOrganizationOfLivingMatter/Epigraph/blob/master/LICENSE
https://github.com/ComplexOrganizationOfLivingMatter/Epigraph/blob/master/LICENSE
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SUPPLEMENTARY FIGURES 1 
 2 
Figure S1. Graphlets and orbits configuration. Illustration of graphlets 3 

networks used in (Pržulj, 2007). Each graphlet configuration is labelled with Gn, 4 

in which, ‘n’ is the graphlets number (from G0 to G29). These labels match with 5 

the cellular motifs in (Fig. 1). Each vertex represents a cell and each edge the 6 

connection between two cells. Therefore, the graphs represent the connectivity 7 

network for each matched cellular motif. The four graphlets labelled in red (G20, 8 

G22, G25 and G27) are the ones discarded in our work. The digits (from 0 to 72) at 9 

some mauve vertices indicate the orbits number counted for the GDD calculation.  10 

  11 
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Figure S2. Pipeline for the Graphlet degree Distribution agreement Distance 1 

(GDD) calculation. Scheme representing the protocol sequence to calculate the 2 

GDD between two segmented images: Eye and Diagram 1. First, a network of 3 

cell-to-cell contacts is computed defining the centroids of valid cells as nodes and 4 

its connections with neighbouring cells as edges. The nodes are represented with 5 

the same colour code as in Fig. 2. Second, the graphlets are extracted from the 6 

network. This enables the calculation of an index of the distribution of every 7 

graphlet. Finally, a comparison between the two Graphlet degree Distributions is 8 

performed to obtain the GDD value.   9 

  10 
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Figure S3. CVTn scale capturing tissue organization. Representation 1 

showing how the CVTn iteratively evolves (Material and Methods) from a 2 

disordered and heterogeneous tessellation (V1) to a more homogeneous and 3 

uniform Voronoi (V700). Each diagram is presented in circles surrounded with 4 

greyscale tones. The series of dots between the circles represent the middle 5 

diagrams amid V4 and V700. CVTn, based on the original CVT path, has been 6 

shown to be a good descriptor for identifying a tissue in homeostatic state. The 7 

graphic displays the resulting relationship between the natural samples and their 8 

most akin Voronoi diagram (signed by a double arrow) in terms of organization 9 

computed by EpiGraph. In addition, it shows which biological samples were 10 

contained within the scale (IN) and which were not (OUT). The colour code of the 11 

actual samples is to the same as that in Fig. 2D. 12 

 13 

  14 
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Figure S4. Comparisons between epithelia and CVTn path. 5-dimensional 1 

scatter plot representing every possible comparison between Epi-Hexagons, Epi-2 

Random, Epi-Voronoi5, percentage of hexagons and shape index. The X and Y 3 

axes for each chart correspond to its column and row names respectively. The 4 

CVTn path is shown starting at diagram 1 until diagram 100 (from 1 to 20, from 5 

30 to 100 by steps of 10), and they are represented in greyscale beginning in 6 

black and reducing its darkness with the increase of the diagrams. A set of natural 7 

epithelia are display: cNT (16 samples, light blue), dWL (15 samples, green), 8 

dWP (16 samples, red), Eye (3 samples, orange) and dMWP (3 samples, violet). 9 

The mean value is represented as a circle and their individual values as smaller 10 

circumferences. In the shape index column, values up to 3.81 represent solid 11 

tissues, painted in orange; shape index values greater than 3.81 indicate fluid 12 

tissues, in green. The histograms represent the dots density along each column 13 

of comparisons. These graphs complement Fig. 2. 14 

 15 

  16 
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Figure S5. Comparisons of the different simulations regarding the CVTn 1 

and natural tissues. All the possible combinations from Epi-Hexagons, Epi-2 

Random, Epi-Voronoi5, percentage of hexagons and shape index in 2-3 

dimensional graphics. The CVTn path is shown starting at the diagram 1 until the 4 

diagram 100 (from 1 to 20, from 30 to 100 by steps of 10). The average values 5 

of 20 replications per diagram, are represented as greyscale dots beginning in 6 

black and reducing its darkness with the increase of the diagrams. Images from 7 

biological samples are marked as dots representing their mean: cNT (16 8 

samples, light blue), dWL (15 samples, green), dWP (16 samples, red), Eye (3 9 

samples, orange) and dMWP (3 samples, violet); Simulations are represented 10 

with their mean (circle) and their individual values (circumference): Proliferative 11 

Control (20 replicates, carnation pink), Case III (17 replicates, hot pink) and Case 12 

IV (15 replicates, purple); Non-proliferative control (20 replicates, blue bell), 13 

Squared (20 replicates, azure blue) and Elongated simulations (20 replicates, 14 

Cornflower Blue). In the shape index column, values up to 3.81 represent solid 15 

tissues, painted in orange; shape index values greater than 3.81 stand for fluid 16 

tissues, in green. The histograms represent the dots density along each column 17 

of comparisons. These graphs complement Fig. 3. 18 
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Figure S6. Shape index values for the analysed images. Plot with shape index 1 

and Epi-Random as axes. The orange region represents the shape index values 2 

that define a tissue as ‘solid’, and the green zone as ‘fluid’. Circles are the 3 

average value obtained from the individual samples from the natural images: Eye, 4 

cNT, dWL, dWP and dMWP; CVTn (from diagram 1 to 100), Proliferative Control, 5 

Case III and Case IV; Non-proliferative control, Squared and Elongated 6 

simulations. Triangles stand for the average value from solid/fluid tissues: WT, 7 

(blue) and Mbs-RNAi (orange). 8 

  9 
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LEGENDS OF SUPPLEMENTARY FILES  1 

Movie S1.  A general example of the usage of EpiGraph. The movie shows all 2 

the functionalities of Epigraph and how to use them, in general terms. 3 

 4 
Table S1. GDD values between pairs of images from images of biological 5 

samples and Voronoi Diagrams. Graphlet degree Distribution agreement 6 

Distance mean between each row and column is shown. Data is divided by the 7 

used cellular motifs (17-motifs and 29-motifs). The used samples are Voronoi 1, 8 

4 and 5: 20 replicates; dWP: 16 replicates; dWL: 15 replicates; Eye: 3 replicates. 9 

 10 

Table S2. GDDs and percentage of hexagons of CVTn reference using all 11 

the cellular motifs sets. Data are distributed depending on the cellular motifs 12 

used (7-motifs, 10-motifs, 17-motifs, 29-motifs). Mean and standard deviation of 13 

percentage of hexagons, Epi-Hexagons, Epi-Random and Epi-Voronoi5 are 14 

shown, along with their associated diagram. 20 replicates of each diagram are 15 

represented. 16 

 17 

Table S3. Outlier detection results of natural images, simulations and 18 

rigid/soft tissues. For the mean of each set of images, the closest diagram and 19 

confidence score are calculated (see Material and methods, statistical analysis). 20 

In green, the confidence score above 0.95 corresponding to inliers. In red are 21 

marked the confidence scores below 0.95, which corresponds to outliers. 22 

 23 

Table S4. Measurements of fluidity from simulations and actual epithelia 24 

using the shape index. The shape index of all the tessellations used along the 25 

manuscript have been calculated in terms of the average of its median and mean 26 

values for each sample. The green colour is referred to a tissue with a shape 27 

index defined as fluid, and the orange colour is identified as solid. 28 

 29 
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